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Global Access v1.01 
Ultra-e Ethernet Communicator 
 
 
Γενικά 

Το λογισµικό Global Access επιτρέπει τον αποµακρυσµένο, ενσύρµατο χειρισµό και την 
τηλεµετρία της συσκευής Ultra-e µέσω ηλεκτρονικού υπολογιστή (PC). Εγκαθιστώντας το 
έχετε τη δυνατότητα να τροποποιείτε τις παραµέτρους της συσκευής χωρίς να βρίσκεστε εκεί. 
Μπορείτε επίσης να παρακολουθείτε από το χώρο σας τις τιµές λειτουργίας της εγκατάστασης 
και µάλιστα να κρατάτε αρχείο µε τις τιµές αυτές. Για τη σύνδεση µεταξύ του Ultra-e και του 
PC απαιτείται σύνδεση Ethernet. 
 

∆υνατότητες 
• Σύνδεση απευθείας σε PC ή µέσω τοπικού δικτύου ή µέσω internet.  
• Ρύθµιση των παραµέτρων λειτουργίας 
• Απεικόνιση και καταγραφή των λειτουργικών µεγεθών 
• Επιλογή των προς απεικόνιση χρήσιµων µεγεθών σε γραφική παράσταση 
• ∆υο ανεξάρτητα επίπεδα πρόσβασης (χρήστης, εγκαταστάτης) 
• Κωδικός πρόσβασης για ασφαλή επικοινωνία 
 

Απαιτήσεις 
Για να λειτουργήσει το λογισµικό Global Access πρέπει να εγκατασταθεί σε προσωπικό 
ηλεκτρονικό υπολογιστή (PC) που είναι εφοδιασµένος µε λειτουργικό σύστηµα Windows. 
Έχουν δοκιµαστεί και λειτουργούν αποτελεσµατικά οι εκδόσεις Vista, XP, 98SE του 
λειτουργικού Windows.  
Κατά την εκτέλεσή του το λογισµικό δεν έχει ιδιαίτερες απαιτήσεις υπολογιστικής ισχύος. Γι 
αυτό η χρήση ενός Pentium 500MHz κρίνεται ικανοποιητική. Η χρησιµοποίηση ισχυρότερου 
PC θα κάνει τη λειτουργία του λογισµικού ακόµα πιο άνετη και οµαλή. Ο υπολογιστής πρέπει 
υποχρεωτικά να είναι εφοδιασµένος µε κάρτα δικτύου Ethernet Base-T 10/100. 
Το Ultra-e είναι και αυτό εφοδιασµένο µε υποδοχή Ethernet. Μπορείτε να συνδέσετε το Ultra-
e µε το PC απευθείας ή µέσω κάποιου δικτύου τοπικού Ethernet ακόµα και µέσω του internet. 
! ΠΡΟΣΟΧΗ Το λογισµικό Global Access εξελίσσεται συνεχώς ώστε να διορθώνονται 
τα πιθανά προβλήµατα και να ενσωµατώνονται νέες δυνατότητες. Αναζητήστε την 
πλέον ενηµερωµένη, Basic έκδοσή του στο www.charmeg.gr. Αν είστε καταχωρηµένος 
χρήστης ζητήστε από τη Charmeg να σας στείλει τη Full έκδοση.  
Για την αντιστοιχία έκδοσης του Ultra-e και του προγράµµατος Global Access συµβουλευθείτε 
τον πίνακα στο τέλος του παρόντος οδηγού.      
 

Εγκατάσταση  
Το λογισµικό διατίθεται σε µορφή συµπιεσµένου αρχείου (zip).  
 
Για την εγκατάστασή του κάντε τα εξής. 

1. Απεγκαταστήστε πιθανές παλαιές εκδόσεις του ίδιου λογισµικού. 
2. Αποσυµπιέσετε το αρχείο αυτό σε έναν οποιονδήποτε φάκελο του υπολογιστή σας. 
3. Τρέξτε το αρχείο setup.exe. 
4. Ο υπολογιστής θα σας καθοδηγήσει στα επόµενα βήµατα. ∆εν έχετε να κάνετε επιλογές κατά 

τη διάρκεια της εγκατάστασης.  Αν ο προκαθορισµένος φάκελος εγκατάστασης δεν σας 
ικανοποιεί θα σας δοθεί η δυνατότητα κατά τη διάρκεια της εγκατάστασης να τον αλλάξετε. 

5. Με την ολοκλήρωση της εγκατάστασης έχει εγκατασταθεί στο µενού του υπολογιστή σας µια 
νέα επιλογή Charmeg> Global Access.  
 

Απεγκατάσταση  
Για να απεγκαταστήσετε το λογισµικό ενεργήστε ως εξής. 

1. Μεταβείτε στο Control Panel (Πίνακα Ελέγχου) των Windows. (Start>Control Panel, 
Έναρξη>Πίνακας Ελέγχου). 
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2. Εντοπίστε το εικονίδιο Add Remove Programs (Προσθαφαίρεση Προγραµµάτων) και 
εκτελέστε το. 

3. Στη λίστα που εµφανίζεται εντοπίστε το πρόγραµµα Global Access και πατήστε 
απεγκατάσταση.  

4. Ακολουθήστε τις οδηγίες του υπολογιστή. 
6. Ποτέ µην προσπαθήσετε να απεγκαταστήσετε το λογισµικό διαγράφοντας τα αρχεία από το 

φάκελο εγκατάστασης. 
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Φυσική σύνδεση 
Για τη φυσική σύνδεση µεταξύ του Ultra-e και του PC που εκτελεί το πρόγραµµα Ethernet 
Communicator µπορούν να ακολουθηθούν διάφορες τοπολογίες. Μπορεί να γίνει απ’ ευθείας 
σύνδεση της συσκευής µε το PC, σύνδεση µέσω τοπικού δικτύου LAN, και σύνδεση µέσω του 
internet.  
 
Ι. Απευθείας σύνδεση 
Για τη σύνδεση αυτή θα χρησιµοποιήσετε καλώδιο UTP-CAT5 (crossed cable) και θα 
συνδέσετε κατευθείαν το PC σας µε το Ultra-e µέσω της θύρας Ethernet. 
 

 

Εικόνα 1 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
ΙΙ. Μέσω τοπικού δικτύου LAN 
Για τη σύνδεση αυτή θα χρησιµοποιήσετε καλώδιο UTP-CAT5 (patch cable). Θα συνδέσετε το 
Ultra-e µέσω του καλωδίου αυτού µε το Router του τοπικού δικτύου.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Εικόνα 2  
 
ΙΙΙ. Μέσω του internet 
Για τη σύνδεση αυτή θα χρησιµοποιήσετε καλώδιο UTP- CAT5 (patch cable). Θα συνδέσετε 
το Ultra-e µέσω του καλωδίου αυτού µε το ROUTER του τοπικού δικτύου. Το τοπικό αυτό 
δίκτυο πρέπει να έχει απ’ ευθείας µόνιµη σύνδεση µε το internet µέσω γραµµής ΑDSL και 
καλό είναι να διαθέτει στατική IP διεύθυνση. Αν δε διαθέτει στατική IP διεύθυνση αλλά 
δυναµική τότε για τη σύνδεση απαιτείται η γνώση της διεύθυνσης αυτής. 
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Ρυθµίσεις 
Αρχικά 
Κάθε συσκευή που συνδέεται σε δίκτυο Ethernet διαθέτει απαραίτητα µια διεύθυνση που 
ονοµάζεται διεύθυνση IP. Η µορφή της διεύθυνσης αυτής είναι δεδοµένη για κάθε υποδίκτυο. 
Είναι υποχρεωτικό κάθε συσκευή που συνδέεται στο δεδοµένο υποδίκτυο να έχει διεύθυνση 
που να υπακούει στη µορφή διευθύνσεων του υποδικτύου. Επίσης η κάθε διεύθυνση πρέπει 
να είναι µοναδική. Η συσκευή Ultra-e διαθέτει προρυθµισµένη τη διεύθυνση 192.168.0.50.  
Μπορείτε να αλλάξετε τη διεύθυνση αυτή χρησιµοποιώντας έναν οποιονδήποτε δικτυακό 
φυλλοµετρητή (Firefox, Opera, Internet Explorer κ.α.). Για την αλλαγή της διεύθυνσης IP του 
Ultra-e πρέπει πρώτα να συνδεθείτε µε κάποιον από τους τρόπους Ι ή ΙΙ που αναφέρθηκαν 
παραπάνω.  
 
Για να το πετύχετε ενηµερωθείτε πρώτα τη διεύθυνση IP του PC σας και τη µορφή των 
διευθύνσεων στο τοπικό σας δίκτυο LAN. Πολύ πιθανόν το τοπικό σας δίκτυο να ακολουθεί τη 
µορφή διευθύνσεων 192.168.0.xxx (όπου xxx ένας αριθµός από το 1 έως το 255). Αν 
συµβαίνει κάτι τέτοιο (τότε το Ultra-e ανήκει ήδη στο ίδιο υποδίκτυο µε το τοπικό σας δίκτυο 
LAN) µπορείτε να συνδέσετε το Ultra-e µε το τοπικό δίκτυο αµέσως ακολουθώντας τον τρόπο 
σύνδεσης ΙΙ.  
 
Αν όχι τότε θα πρέπει να αλλάξετε τη διεύθυνση του PC σας ώστε να βρεθεί αυτό στο ίδιο 
υποδίκτυο µε το Ultra-e. Για να το πετύχετε αλλάξτε τη διεύθυνση του PC σε κάποια της 
µορφής 192.168.0.xxx όπου το xxx είναι ένας αριθµός από 1 έως 255, εκτός από το 50 που 
καταλαµβάνεται από το Ultra-e. Προτείνεται πριν την αλλαγή να σηµειώσετε τις παλιές 
ρυθµίσεις ώστε µετά να µπορείτε να επαναφέρετε το PC στην αρχική του κατάσταση. Όταν 
PC και Ultra-e βρεθούν στο ίδιο υποδίκτυο µπορείτε να ακολουθήσετε τη σύνδεση Ι ή ΙΙ.  
 
Ανοίγοντας τον φυλλοµετρητή και πληκτρολογώντας τη διεύθυνση 192.168.0.50 του Ultra-e 
θα εµφανιστεί η πρώτη σελίδα του όπως φαίνεται στην Εινόνα 4.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Εικόνα 4  
 

Στην προτροπή για εισαγωγή ονόµατος χρήστη και κωδικού πρόσβασης µην εισάγετε τίποτα 
και πατήστε απλώς το OK. Θα εµφανιστεί η Εικόνα 5. 
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Εικόνα 5 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Από την αριστερή στήλη επιλέξτε το Network. Σας ανοίγει η οθόνη της Εικόνας 6. Εντοπίστε 
και αλλάξτε την τιµή του IP Address και του Subnet Mask. Όταν θα εισάγετε την τιµή της IP 
Address το ίδιο το πρόγραµµα θα σας προτείνει και τη σωστή τιµή για το Subnet Mask. 
 
∆εν είναι απαραίτητο να αλλάξετε τίποτε άλλο. Για να ολοκληρώσετε τη διαδικασία πατήστε 
OK και από την αριστερή στήλη Apply Settings. Περιµένετε µέχρι να τελειώσει η µεταφορά 
των πληροφοριών και στη συνέχεια κλείστε το φυλλοµετρητή. 
 
 
! ΠΡΟΣΟΧΗ Η αλλαγή της διεύθυνσης του Ultra-e δεν είναι δύσκολη. Προσέξτε όµως 
να µην µεταβάλλετε κατά λάθος ή από περιέργεια καµία άλλη ρύθµιση διότι είναι 
δυνατόν να χάσετε εντελώς την πρόσβαση σε αυτό. Στην περίπτωση αυτή η συσκευή 
Ultra-e θα πρέπει να επιστραφεί για επαναπρογραµµατισµό. 
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Συνδέσεις 
Αφού ολοκληρώσετε την αλλαγή της διεύθυνσης IP του Ultra-e ώστε να βρεθεί στο ίδιο 
υποδίκτυο που πρόκειται να λειτουργήσει είστε έτοιµοι για τη σύνδεση. Ανάλογα µε ποιον 
τρόπο από τους Ι, ΙΙ, ΙΙΙ έχετε επιλέξει πρέπει να κάνετε τα παρακάτω. 
 
Ι. Απευθείας σύνδεση  
Για την απευθείας σύνδεση δεν απαιτείται καµία επιπλέον ενέργεια. Εκκινήστε το λογισµικό 
Ethernet Communicator. 
 
ΙΙ. Μέσω τοπικού δικτύου LAN  
Για τη σύνδεση µέσω τοπικού δικτύου LAN αποσυνδέστε το UTP-CAT5 (crossed cable) από 
το PC και από το Ultra-e. Στη συνέχεια συνδέστε το PC µε το ROUTER του LAN σας µέσω 
του 
κανονικού UTP (patch cable). Συνδέστε επίσης το Ultra-e µε το ROUTER µέσω καλωδίου 
UTP-CAT5 (patch cable). Θυµηθείτε να επαναφέρετε τις ρυθµίσεις του PC σας ώστε να 
βρεθεί στο υποδίκτυο του τοπικού σας LAN. Εκκινήστε το λογισµικό Global Access. 
 
ΙΙΙ. Μέσω του internet 
Η σύνδεση µέσω του internet απαιτεί µερικά ακόµα βήµατα. Σε µια σύνδεση ADSL το ADSL 
modem έχει µια µοναδική διεύθυνση IP στο Internet. Η διεύθυνση αυτή (στατική ή δυναµική) 
πρέπει να σας είναι γνωστή. Το ADSL modem συνδέεται επίσης µε το τοπικό LAN µέσω ενός 
ROUTER. Πολλές φορές το ROUTER αυτό ενσωµατώνεται στο ADSL modem. Το τοπικό 
δίκτυο LAN όπως είπαµε έχει τη δική του µορφή διευθύνσεων. Η µορφή αυτή είναι εντελώς 
ανεξάρτητη από τη διεύθυνση IP που έχει το ADSL modem στο internet.  
 
Ας υποθέσουµε τώρα ότι έχουµε µια εγκατάσταση στην οποία θέλουµε να τοποθετήσουµε το 
Ultra-e. Αρχικά πρέπει να µάθουµε τη µορφή των διευθύνσεων του τοπικού δικτύου LAN και 
να δώσουµε στο Ultra-e µια µοναδική διεύθυνση που να ανήκει του υποδίκτυο αυτό. Ο 
τρόπος αλλαγής περιγράφηκε παραπάνω.  
 
Αποµένει ένα ακόµα στάδιο. Ονοµάζεται Port forwarding (προώθηση θύρας) και είναι 
απαραίτητο στην περίπτωση αυτή. Ο λόγος ύπαρξης του σταδίου αυτού είναι προφανής. 
Όταν παρεµβάλλεται το internet µεταξύ PC και Ultra-e το λογισµικό Ethernet Communicator 
καλεί το Ultra-e µέσω της internet IP διεύθυνσης του ADSL modem. Η κλήση γίνεται αλλά η 
πληροφορία που φτάνει στο ADSL modem πρέπει να ανακατευθυνθεί στο Ultra-e που 
βρίσκεται στο τοπικό LAN. Η διαδικασία Port forwarding κάνει ακριβώς αυτό. Λέει δηλαδή στο 
ADSL modem ότι αν έρθει κλήση από το internet που να αφορά το Ultra-e τότε να κατευθύνει 
την κλήση αυτή στην τοπική διεύθυνση που έχει το Ultra-e. Πώς όµως γνωρίζει το ADSL 
modem ότι η κλήση απευθύνεται στο Ultra-e ώστε να τη στείλει εκεί; Όταν γίνεται κάποια 
κλήση το λογισµικό δε χρησιµοποιεί µόνο τη διεύθυνση IP του Ultra-e. Στην πραγµατικότητα 
χρησιµοποιεί και έναν ακόµα λιγότερο γνωστό αριθµό που λέγεται Port. To Ultra-e 
χρησιµοποιεί την Port µε αριθµό 10001. Και αυτός ο αριθµός µπορεί επίσης να αλλάξει αν 
υπάρχει λόγος. To Port forwarding λοιπόν στηρίζεται στο εξής: δέχεται τις κλήσεις µέσω του 
internet και σε συγκεκριµένη Port και τις ανακατευθύνει σε συγκεκριµένη διεύθυνση του 
τοπικού LAN και στην ίδια Port. Πώς όµως το γνωρίζει αυτό το ADSL modem ώστε να το 
κάνει; ∆εν το γνωρίζει. Θα πρέπει να ρυθµιστεί. Όλα τα καλά ADSL modems ακόµα και τα 
οικονοµικά διαθέτουν πλέον τη λειτουργία του Port forwarding.  
 
Πρέπει λοιπόν να µπείτε στο menu ρύθµισης του ADSL modem και να ρυθµίσετε το Port 
forwarding ώστε όταν λαµβάνει κλήση στην Port 10001 να την κατευθύνει στην τοπική 
διεύθυνση του Ultra-e και στην ίδια Port.  
 
Με την ολοκλήρωση του σταδίου αυτού είστε έτοιµοι για να επικοινωνήσετε µε το Ultra-e 
µέσω internet. Εκκινήστε το λογισµικό Ethernet Communicator. To PC που εκτελείται το 
λογισµικό πρέπει ασφαλώς να έχει πρόσβαση στο internet. ∆εν είναι απαραίτητο η πρόσβαση 
αυτή να είναι ADSL. Αρκεί µια σύνδεση ISDN ή ακόµα και µια απλή Dial-up.  

Επεξηγήσεις 
Γενικά 
Το λογισµικό Global Access διαθέτει δυο διαφορετικές εκδόσεις που συνιστούν δυο επίπεδα 
προσβασιµότητας.  
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1. Την έκδοση Basic µε την οποία µπορείτε να διαβάσετε τις τιµές και τις παραµέτρους του Ultra-
e. Μπορείτε επίσης να συλλέξετε τις τιµές των µετρήσεων και να τις απεικονίσετε γραφικά ή 
και να τις αποθηκεύσετε σε αρχεία. ∆ε µπορείτε να µεταβάλλετε τις τιµές αυτές. Η έκδοση 
Basic προορίζεται για τον ενδιαφερόµενο τελικό χρήστη και διατίθεται στο internet.  

2. Την έκδοση Full µε την οποία µπορείτε να κάνετε όλα όσα µε την έκδοση Basic. Επιπλέον 
µπορείτε να µεταβάλλετε τις τιµές του Ultra-e. Η µεταβολή των παραµέτρων, ιδιαίτερα όταν 
γίνεται µε τρόπο αποµακρυσµένο, απαιτεί µεγάλη προσοχή και εµπειρία. Η έκδοση Full 
απευθύνεται µόνο σε εγκαταστάτες και έµπειρους χρήστες. ∆ε διατίθεται ελεύθερα στο 
internet και φέρει συγκεκριµένο αριθµό καταχώρησης (registration number) που σχετίζεται 
άµεσα µε τον αγοραστή του Ultra-e.    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Όταν εκκινείται το λογισµικό Ethernet Communicator εµφανίζεται η Εικόνα 7 και αµέσως µετά 
το Κεντρικό Παράθυρο  του Global Access της Εικόνας 8. Από εδώ µπορείτε να κάνετε 
όλους τους βασικούς χειρισµούς. 
 
Κεντρικό Παράθυρο Ultra-e Ethernet Communicator 
 
Περιλαµβάνει το πλαίσιο Communication στο οποίο παρουσιάζονται πληροφορίες σχετικές µε 
την επικοινωνία.  
 
Tx/Rx ∆ίπλα ακριβώς υπάρχει ένα πλαίσιο. Εντός του πλαισίου βρίσκονται δυο έγχρωµοι 
οπτικοί ενδείκτες. Ο κίτρινος ανάβει όταν γίνεται αποστολή πληροφοριών και ο πορτοκαλής 
όταν γίνεται λήψη. Είναι πολύ σηµαντικό στοιχείο διότι µας δείχνει την δραστηριότητα στη 
διασύνδεση Ethernet. 
 
IP Address, Port, SIP Address, Retries είναι οι τιµές των αντίστοιχων µεταβλητών 
επικοινωνίας. Εδώ µπορείτε απλά να δείτε τις τιµές των παραµέτρων. Η σηµασία και ο 
τρόπος µεταβολής τους θα εξηγηθεί στην ενότητα Parameters πιο κάτω.     
 
Το κουµπί Connect & Login ανοίγει τη σύνδεση Ethernet µε το Ultra-e και µας επιτρέπει να 
εισάγουµε τον κωδικό ασφαλείας ώστε να µας επιτραπεί η πρόσβαση.  
∆ίπλα από το κουµπί βρίσκεται ένας φωτεινός ενδείκτης. Όταν είναι κόκκινος δεν έχει γίνει 
σύνδεση Ethernet. Όταν είναι πράσινος έχει επιτευχθεί σύνδεση Ethernet.  
 
Το κουµπί Logout διακόπτει την πρόσβαση µε τον παρόντα κωδικό ασφαλείας στο Ultra-e 
αλλά διατηρεί τη σύνδεση Ethernet ανοιχτή. 
 
∆ίπλα από το πλήκτρο εµφανίζεται ένας µπλε ενδείκτης όταν έχει επιτευχθεί πρόσβαση µε το 
σωστό κωδικό ασφαλείας. 
 
Το κουµπί Disconnect κλείνει τη σύνδεση Ethernet αφού προηγουµένως διακόπτει την 
πρόσβαση µε τον παρόντα κωδικό (logout). 
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Το κουµπί Exit τερµατίζει τη λειτουργία του προγράµµατος. 
 
Μενού File 
Περιλαµβάνει µόνο την επιλογή Exit. Επιλέγοντάς τη κλείνουµε το πρόγραµµα. 
 
Μενού Parameters 
Για να ρυθµίσετε τις παραµέτρους επικοινωνίας από το µενού Parameters>Communication 
ενεργοποιήστε την αντίστοιχη φόρµα. Αµέσως εµφανίζεται η Εικόνα 9. 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
Στα πεδία της IP Address εισάγετε την IP του Ultra-e αν η σύνδεση που ακολουθείτε είναι 
τύπου Ι ή ΙΙ. Αν έχετε ακολουθήσει σύνδεση τύπου ΙΙΙ τότε εισάγετε την internet διεύθυνση του 
ADSL modem. Το πεδίο Port περιέχει τον αριθµό της Port στην οποία θα γίνει η κλήση. 
Συνήθως δεν υπάρχει λόγος να αλλάξει. Αν παρόλα αυτά χρειαστεί να µεταβληθεί θυµηθείτε 
ότι πρέπει να εισάγετε την ίδια τιµή και στο Ultra-e.  
 
Υπάρχουν επίσης δυο ακόµα παράµετροι των οποίων την τιµή µπορείτε να µεταβάλλετε. Η 
SIP Address και ο αριθµός Retries. Το SIP προέρχεται από τα αρχικά των λέξεων Serial 
Intercommunication Protocol και αποτελεί πνευµατική ιδιοκτησία της εταιρείας Charmeg. Το 
λογισµικό Ethernet Communicator επικοινωνεί µε το Ultra-e χρησιµοποιώντας το Εthernet 
αλλά στέλνοντας εντολές του πρωτοκόλλου SIP. Στο πρωτόκολλο SIP κάθε συσκευή έχει 
επίσης µια µοναδική διεύθυνση που είναι ένας αριθµός από το 1 έως το 255. Οι συσκευές 
Ultra-e έχουν διεύθυνση SIP 5 ή οποία δε µπορεί να µεταβληθεί. Συνεπώς δεν υπάρχει λόγος 
να αλλάξετε την τιµή του πεδίου SIP Address. Αν το κάνετε δε θα µπορείτε να επικοινωνήσετε 
µε το Ultra-e. 
 
O αριθµός Retries είναι πολύ σηµαντικός. Σε περιπτώσεις κατά τις οποίες η επικοινωνία δεν 
είναι καλή ο Ultra-e µπορεί να µην λάβει την κλήση ή να την λάβει λάθος. Μπορεί επίσης να 
τη λάβει σωστά αλλά η πληροφορία να µην επιστρέψει σωστά στο PC. Ο αριθµός Retries 
ρυθµίζει πόσες προσπάθειες επανάκλησης πρέπει να γίνουν σε περίπτωση κακής 
επικοινωνίας. Μια καλή τιµή είναι το 5. Σε περιπτώσεις πολύ κακής επικοινωνίας µπορείτε να 
το αυξήσετε έως το 10. 
 
Το κουµπί Save αποθηκεύει τις τιµές. Το κουµπί Exit κλείνει το παράθυρο χωρίς να σώσει τις 
τιµές.  
 
Μενού Tools 
Εδώ θα βρείτε τρεις επιλογές. Η πρώτη Tools>Ultra Configurator σας οδηγεί στη φόρµα 
ανάγνωσης και τροποποίησης των παραµέτρων του Ultra-e. 
 
Η δεύτερη Tools>Ultra Monitor σας οδηγεί στη φόρµα παρακολούθησης των µετρήσεων της 
συσκευής. Σε αυτή τη φόρµα µπορείτε να δείτε τις γραφικές παραστάσεις των θερµοκρασιών 
και να τις αποθηκεύσετε σε αρχεία. 
 
Η τρίτη επιλογή Tools>Advanced δεν είναι διαθέσιµη στις εκδόσεις Basic και Full.  
 
Οι επιλογές του µενού Tools µπορούν να γίνουν µόνο όταν υπάρχει ενεργή σύνδεση µεταξύ 
του PC και του Ultra-e. Σε οποιαδήποτε άλλη περίπτωση λαµβάνετε µήνυµα λάθους. 
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Μενού Help 
Περιέχει την επιλογή About από την οποία µπορείτε να λάβετε µερικές χρήσιµες πληροφορίες 
της έκδοσης του προγράµµατος. 
 
Παράθυρο Ultra-e Configurator 
 
Μέσα στο παράθυρο Ultra-e Configurator (Εικόνα 10) υπάρχουν έξι πλαίσια. Το καθένα τους 
αναφέρεται σε ένα σύνολο παραµέτρων του Ultra-e. Επίσης το καθένα τους περιέχει τρία 
κουµπιά. Το κουµπί Read διαβάζει τις παραµέτρους που είναι γραµµένες στο Ultra-e. Το 
κουµπί Write γράφει τις παραµέτρους στο Ultra-e. Το κουµπί Verify δεν είναι ενεργοποιηµένο.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Κάτω από το κάθε σύνολο των τριών κουµπιών υπάρχει ένα πλαίσιο µηνύµατος που µας 
ενηµερώνει για το αποτέλεσµα της εντολής Write. Όταν εµφανίζει OK σηµαίνει ότι η εγγραφή 
των παραµέτρων στο Ultra-e έγινε µε επιτυχία. Το αντίθετο συµβαίνει όταν εµφανίζει ERROR. 
 
Κάτω αριστερά υπάρχει επίσης ένα παράθυρο στο οποίο εµφανίζεται η γραφική απεικόνιση 
της διαµόρφωσης που έχει επιλεγεί. 
 
Condition ∆ιαβάζει τις θερµοκρασίες των αισθητηρίων και τις απεικονίζει στα σχετικά πλαίσια 
που βρίσκονται από πάνω. Ταυτόχρονα εµφανίζει και τα πιθανά προβλήµατα των 
αισθητηρίων.  
 
Reset Επανεκκινεί τη συσκευή Ultra-e. Όταν ολοκληρωθεί ο αποµακρυσµένος 
προγραµµατισµός της συσκευής συνιστάται επανεκκίνηση. 
 
Read all Εκτελεί ανάγνωση όλων των παραµέτρων. Είναι σαν να πατάµε όλα τα πλήκτρα 
Read. 
 
Write all Εκτελεί εγγραφή όλων των παραµέτρων. Είναι σαν να πατάµε όλα τα πλήκτρα Write. 
 
Clear all Καθαρίζει όλα τα πλαίσια.  
 
Exit Κλείνει τη φόρµα Ultra-e Configurator 
 
Mενού File 
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Load Φορτώνει το αρχείο που περιλαµβάνει τις παραµέτρους του Ultra-e. 
 
Save As Σώζει τις τιµές σε αρχείο µε όνοµα που δίνετε εσείς ώστε να µπορείτε να τις 
ανακαλέσετε στη συνέχεια. 
 
Exit Επιλέγοντάς τη κλείνουµε το πρόγραµµα. 
 
Μενού Help 
Περιέχει την επιλογή About από την οποία µπορείτε να λάβετε µερικές χρήσιµες πληροφορίες 
της έκδοσης του προγράµµατος. 
 
Παράθυρο Ultra-e Monitor 
Στο παράθυρο που φαίνεται στην Εικόνα 11 µπορείτε να δείτε την λειτουργία του Ultra-e µε 
παραστατικό τρόπο και να κάνετε µελέτη της λειτουργίας του. Μπορείτε να λαµβάνετε 
συνεχώς δεδοµένα και να τα απεικονίζετε στην οθόνη. Τα δεδοµένα µπορούν να 
αποθηκεύονται σε αρχείο ώστε να γίνει εκ των υστέρων µελέτη. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Το παράθυρο περιλαµβάνει µια κεντρική οθόνη στην οποία γίνεται η γραφική απεικόνιση των 
θερµοκρασιών των αισθητηρίων. 
 
Αριστερά αυτής περιλαµβάνει το πλαίσιο Setup. Από αυτό µπορούν να επιλεγούν ποια 
αισθητήρια θα απεικονίζονται στη γραφική παράσταση. Μπορεί επίσης να επιλεγεί και το αν 
τα δεδοµένα θα εγγράφονται σε αρχείο ή όχι. 
 
Υπάρχει επίσης το πλαίσιο Readout. Εδώ µπορείτε να διαβάσετε τις θερµοκρασίες των 
αισθητηρίων, το εάν κάποιο από αυτά παρουσιάζει σφάλµα καθώς και την κατάσταση των 
τριών ρελέ εξόδου. 
 
Logger Start Το κουµπί αυτό ενεργοποιεί τη συνεχόµενη διαδικασία ανάγνωσης, απεικόνισης 
και αποθήκευσης των µετρήσεων. 
 
Logger Stop Το κουµπί αυτό σταµατάει τη διαδικασία ανάγνωσης, απεικόνισης και 
αποθήκευσης των µετρήσεων. 
 
Exit Κλείνει το παράθυρο Ultra-e Monitor 
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Στο κάτω µέρος υπάρχει επίσης και µια µπάρα κύλισης µέσω της οποίας ρυθµίζετε κάθε 
πόσα δευτερόλεπτα θα γίνεται ανάγνωση και απεικόνιση των µετρήσεων. ∆ίπλα της υπάρχει 
και το πλαίσιο που παρουσιάζει την τρέχουσα τιµή. 
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Λειτουργία 
Αφού εγκαταστήσετε το λογισµικό Global Access είστε έτοιµοι για τη λειτουργία του. 
Υπενθυµίζεται ότι πρέπει να έχετε ήδη κάνει τις σχετικές φυσικές συνδέσεις µε αντίστοιχα 
καλώδια καθώς και να έχετε επιλέξει µεταξύ των διαθέσιµων τρόπων επικοινωνίας (Ι, ΙΙ ή ΙΙΙ). 
 
Μετά την εκκίνηση του προγράµµατος εµφανίζεται για λίγο η εισαγωγική οθόνη στην οποία 
παρουσιάζονται πληροφορίες σχετικές µε την έκδοση και την άδεια χρήσης. Ακολουθεί το 
κεντρικό παράθυρο του προγράµµατος. 
 
 
 
 
 
 
 
 
 
 
 
 
Κεντρικό παράθυρο Global Access 

Εικόνα 12 

i. Από το µενού επιλέξτε Parameters>Communication ώστε να εµφανιστεί η φόρµα εισαγωγής 
των παραµέτρων επικοινωνίας. ∆ώστε τις σωστές τιµές όπως εξηγήθηκε παραπάνω. 
Πατήστε Save και στη συνέχεια Exit. 

ii. Στο κεντρικό παράθυρο πατήστε Connect & Login. Όταν το πατήσετε το πρόγραµµα 
προσπαθεί να αποκαταστήσει τη σύνδεση µε τη συσκευή Ultra-e. Αν το επιτύχει ο κόκκινος 
ενδείκτης που βρίσκεται δίπλα γίνεται πράσινος. Τότε συνεχίστε στο επόµενο βήµα Αν δεν 
γίνει πράσινος τότε η σύνδεση Ethernet δεν έχει επιτευχθεί και δεν ωφελεί να συνεχίσετε. 
Πρέπει απαραίτητα να αποκατασταθεί η σύνδεση ethernet. 

iii. Αν η σύνδεση ethernet έχει αποκατασταθεί τότε σε λίγο εµφανίζεται το παράθυρο εισαγωγής 
του µυστικού οκταψήφιου κωδικού (Εικόνα 12) που θα σας επιτρέψει να αποκτήσετε 
πρόσβαση στον προγραµµατισµό του Ultra-e. O κωδικός εµφανίζεται σαν τέσσερα διψήφια 
νούµερα. Η τιµή που εµφανίζεται είναι το 00 00 00 00 (όλα µηδενικά). Τον ίδιο κωδικό έχει 
αρχικά και το Ultra-e προρυθµισµένο από το εργοστάσιο. Προτείνεται να αλλαχτεί ο κωδικός 
αυτός µε κάποιον δικό σας ώστε να µην έχουν άλλοι πρόσβαση στη συσκευή Ultra-e µε 
αποµακρυσµένο τρόπο. 

iv. Πατήστε Login. Το λογισµικό προσπαθεί να αποκτήσει πρόσβαση στο Ultra-e. Αν το επιτύχει 
ένας µπλε ενδείκτης εµφανίζεται δίπλα στο πλήκτρο Logout. Αν δεν το επιτύχει (και αυτό 
µπορεί να γίνει για διάφορους λόγους) δεν ωφελεί να συνεχίσετε. Προσπαθήστε να 
εντοπίσετε την αιτία και ξαναπροσπαθήστε.  Αν ο µπλε ενδείκτης εµφανιστεί τότε σηµαίνει ότι 
έχετε συνδεθεί και σας έχει επιτραπεί η πρόσβαση οπότε µπορείτε να συνεχίσετε στο 
επόµενο βήµα. 

v. Αν θέλετε να κάνετε προγραµµατισµό του Ultra-e ή ανάγνωση των ήδη υπαρχόντων 
παραµέτρων πατήστε Tools>Ultra Configurator. Αν έχετε συνδεθεί και αποκτήσει δικαιώµατα 
πρόσβασης θα ανοίξει το παράθυρο Ultra Configurator. 

vi. Αν θέλετε να δείτε τις τιµές και τη λειτουργία του Ultra-e πατήστε Tools>Ultra Monitor. Αν 
προηγουµένως είχατε συνδεθεί και είχατε αποκτήσει δικαίωµα πρόσβασης θα ανοίξει το 
παράθυρο Ultra Monitor.    
 
! ΠΡΟΣΟΧΗ Από τη στιγµή που θα αποκτήσετε δικαίωµα µεταβολής των 
παραµέτρων του Ultra-e έχετε στη διάθεσή σας 60sec για να εκτελέσετε µια 
οποιαδήποτε εντολή επικοινωνίας µε τη συσκευή. Για λόγους ασφαλείας η συσκευή 
διακόπτει το δικαίωµα επικοινωνίας όταν παρέλθει το χρονικό αυτό διάστηµα χωρίς 
να εκτελεστεί καµία επικοινωνία. Στην περίπτωση αυτή ενδέχεται ο µπλε ενδείκτης να 
ανάβει. Για να ξαναποκτήσετε δικαίωµα πρόσβασης ξαναπατήστε Connect & Login. 
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Παράθυρο Ultra Configutator 
 
Από το µενού του Ultra-e Configurator επιλέξτε Load. Στη φόρµα που θα εµφανιστεί επιλέξτε 
το αρχείο ultra_1.set. To αρχείο αυτό περιλαµβάνει ένα τυπικό παράδειγµα τιµών των 
παραµέτρων του Ultra-e. Το λογισµικό αποθηκεύει τις τιµές πάντα σε αρχεία µε κατάληξη .set. 
Από την επιλογή File>Save As  µπορείτε να αποθηκεύσετε τα δικά σας αρχεία µε το όνοµα 
που επιθυµείτε. Έτσι µπορείτε να έχετε τις τιµές ρύθµισης των εγκαταστάσεων που έχετε 
κάνει πάντα µαζί σας π.χ. ΠΕΛΑΤΗΣ_1.set. 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Πατώντας κάποιο από τα πλήκτρα Read λαµβάνετε τις τιµές του αντίστοιχου πλαισίου.  

 
Πατώντας κάποιο από τα πλήκτρα Write γράφετε τις τιµές του αντίστοιχου πλαισίου στη 
µνήµη του Ultra-e. Αν η εγγραφή γίνει σωστά στο κάτω µέρος του πλαισίου απεικονίζεται το 
µήνυµα OK. ∆ιαφορετικά λαµβάνετε το µήνυµα ERROR. Στην περίπτωση που λάβετε µήνυµα 
ERROR επιχειρήστε νέα εγγραφή µέχρι να λάβετε OK. Για να είστε σίγουροι ότι οι σωστές 
τιµές αποθηκεύτηκαν στη συσκευή επιβάλλεται να εκτελέσετε ανάγνωση όλων των τιµών µετά 
την ολοκλήρωση της εγγραφής.   
 
Πατώντας το πλήκτρο Read all κάνετε ανάγνωση όλων των πλαισίων σειριακά. Πατώντας το 
Write All γράφετε σειριακά στη µνήµη του Ultra-e τις τιµές που υπάρχουν στα αντίστοιχα 
πλαίσια. 
 
Με το πλήκτρο Clear all µπορείτε να καθαρίσετε τα πλαίσια ώστε π.χ. να ακολουθήσει µια νέα 
ανάγνωση των τιµών για λόγους επιβεβαίωσης και καλής λήψης.  
 
! ΠΡΟΣΟΧΗ Αν διαπιστώσετε ότι η επικοινωνία είναι δυσχερής και οι εντολές Read 
all και Write all καθυστερούν και δεν ολοκληρώνονται µε επιτυχία τότε επιχειρήστε να 
διαβάσετε ή να γράψετε τις τιµές των πλαισίων χρησιµοποιώντας τις µεµονωµένες 
εντολές Read και Write. 
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! ΠΡΟΣΟΧΗ απαιτείται στην περίπτωση που εκτελείτε Write ή και Write all. Οι τιµές 
που πρόκειται να εγγραφούν πρέπει να έχουν ελεγχθεί σχολαστικά. ∆ιαφορετικά είναι 
δυνατόν η συσκευή να µη λειτουργεί κανονικά. Ενηµερωθείτε για τη σηµασία της κάθε 
παραµέτρου και εισάγετε τις τιµές µε µεγάλη επιµέλεια. Λανθασµένες τιµές είναι 
δυνατόν να βλάψουν τη εγκατάσταση και να προξενήσουν σοβαρές δυσλειτουργίες. 
  
Το πλήκτρο Condition διαβάζει τις παρούσες τιµές θερµοκρασιών των αισθητηρίων και τα 
πιθανά προβλήµατα. Η ανάγνωση γίνεται µία φορά. Για να δείτε τις νέες τιµές ξαναπατήστε το 
ίδιο πλήκτρο. 
 
Με το πλήκτρο Reset γίνεται επανεκκίνηση της συσκευής. Επανεκκίνηση προτείνεται στην 
περίπτωση εκτεταµένων αλλαγών στις παραµέτρους του Ultra-e. Η επανεκκίνηση από την 
πλευρά του Ultra-e απαιτεί χρόνο µερικών δευτερολέπτων. Επίσης µε την επανεκκίνηση το 
λογισµικό Global Access χάνει τη σύνδεση και το δικαίωµα πρόσβασης. Γι αυτό θα πρέπει να 
ξαναπατήσετε το Connect and Login.  
 
Παράθυρο Ultra Monitor 
Από το παράθυρο αυτό µπορείτε να παρακολουθείτε τη λειτουργία του Ultra-e, την εξέλιξη 
των θερµοκρασιών, τις λειτουργικές παραµέτρους και τα ρελέ που είναι ενεργοποιηµένα. 
Μπορείτε επίσης να καταγράφετε τις θερµοκρασίες και τους κωδικούς προβληµάτων σε 
αρχείο για περαιτέρω επεξεργασία και εξαγωγή συµπερασµάτων.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Πατήστε το πλήκτρο Logger Start για να ξεκινήσει η διαδικασία ανάγνωσης και απεικόνισης. 
Για να σταµατήσει πατήστε το πλήκτρο Logger Stop. 
 
Όπως προαναφέρθηκε η συσκευή Ultra-e αν παρέλθει χρονικό διάστηµα µεγαλύτερο των 
60sec δίχως να λάβει καµία σωστή κλήση διακόπτει το δικαίωµα πρόσβασης προς το 
πρόγραµµα που την έχει καλέσει. Όταν έχετε πατήσει το πλήκτρο Logger Start  το 
πρόγραµµα στέλνει στο Ultra-e εντολές ανάγνωσης κάθε 1sec. Εποµένως τέτοιος κίνδυνος 
δεν υπάρχει. Αν όµως δεν έχει ενεργοποιηθεί το Logger Start τότε το δικαίωµα της 
πρόσβασης θα διακοπεί. 
 
Στο πλαίσιο που βρίσκεται αριστερά µπορείτε να επιλέξετε αν τα δεδοµένα θα καταχωρούνται 
ή όχι σε αρχείο. Αυτό γίνεται µε την επιλογή File logging. Το αρχείο που δηµιουργείται λέγεται 
ultradata.txt και το όνοµά του δε µπορεί να µεταβληθεί. Αν το σβήσετε το λογισµικό Global 

Εικόνα 14

, info@charmeg.gr 
Global_Access_Users_Manual_1.doc 

- 15 - 



 

Charmeg Κότρωνος 27, Αιγάλεω, Αθήνα, Ελλάδα, Τηλ. +30 210 5693111 Fax +30 210 5693093 www.charmeg.gr

Access θα δηµιουργήσει νέο µε το ίδιο όνοµα. Τα νέα δεδοµένα γράφονται στο τέλος του 
αρχείου. 
 
Μπορείτε να δείτε τα περιεχόµενα του αρχείου αυτού ανοίγοντάς το µε έναν απλό text editor 
όπως το Σηµειωµατάριο (Notepad) των Windows. Κάθε γραµµή αντιστοιχεί µε µια 
επιτυχηµένη µέτρηση. Οι ανεπιτυχείς µετρήσεις δε γράφονται στο αρχείο. Κάθε γραµµή 
ξεκινάει µε την ηµεροµηνία και την ώρα που λήφθηκε η µέτρηση. Ακολουθούν οι 
θερµοκρασίες των τεσσάρων αισθητηρίων και µετά η κατάσταση καθ’ ενός από τα αισθητήρια. 
Ο κωδικός 0 σηµαίνει ότι δεν υπάρχει πρόβληµα. Κωδικός 1 σηµαίνει ότι υπάρχει πρόβληµα 
στο αντίστοιχο αισθητήριο. Στο τέλος της κάθε γραµµής υπάρχει καταχωρηµένη η κατάσταση 
των τριών ρελέ εξόδου του Ultra-e. 
 
Από το ίδιο πλαίσιο µπορείτε να επιλέξετε τα αισθητήρια η θερµοκρασία των οποίων θα 
εµφανίζεται στη γραφική παράσταση. Υπάρχει χρωµατικός κώδικας ώστε να διακρίνεται η 
θερµοκρασία του κάθε αισθητηρίου. Η επιλογή της απεικόνισης αφορά µόνο τη γραφική 
παράσταση. Στο αρχείο γράφονται πάντα οι θερµοκρασίες όλων των αισθητηρίων και όλοι οι 
κωδικοί των προβληµάτων.  
 
Στο πλαίσιο Readout µπορείτε να δείτε τις θερµοκρασίες των αισθητηρίων, τα πιθανά 
προβλήµατα σε κάποιο ή κάποια από αυτά καθώς και την κατάσταση των ρελέ εξόδου.  
 
Από την κυλιόµενη µπάρα που βρίσκεται στο κάτω µέρος της φόρµας µπορείτε να επιλέξετε 
κάθε πότε θα ανανεώνονται τα δεδοµένα της γραφικής παράστασης και θα καταχωρούνται τα 
νέα στο αρχείο ultradata.txt. Ο αριθµός αντιστοιχεί σε σωστές αναγνώσεις που εκτελούνται 
κάθε 1 sec. Εποµένως αν υπάρχει καλή επικοινωνία και όλες οι προσπάθειες ανάγνωσης 
είναι επιτυχείς τότε η παράσταση ανανεώνεται κάθε τόσα δευτερόλεπτα όσα λέει η τιµή 
interval. Αν η επικοινωνία δεν είναι καλή πολλές από τις αναγνώσεις που γίνονται κάθε 1sec 
θα είναι ανεπιτυχείς. Εποµένως η ανανέωση της παράστασης και η εγγραφή στο αρχείο θα 
γίνεται σε χρονικό διάστηµα µεγαλύτερο του interval σε δευτερόλεπτα.  
 
Η τιµή του Interval µπορεί να µεταβληθεί από 1sec έως 3600sec που αντιστοιχεί σε 1 ώρα.  
 
Λόγω των πιθανών ανεπιτυχών επικοινωνιών είναι πιθανό ο οριζόντιος άξονας να µην 
αντιστοιχεί στον απόλυτο χρόνο. Ο κατακόρυφος άξονας δεν επηρεάζεται. 

     
! ΠΡΟΣΟΧΗ Μπορείτε να έχετε ανοιγµένα τα παράθυρα Ultra Configurator και Ultra 
Monitor ταυτόχρονα ώστε να βλέπετε τις παραµέτρους προγραµµατισµού και τη 
γραφική παράσταση. Είναι παρακινδυνευµένο όµως να στέλνετε εντολές και από τα 
δυο παράθυρα ταυτόχρονα. Γι αυτό διακόψτε την εκτέλεση του Logger όταν εκτελείτε 
οποιαδήποτε εντολή από το παράθυρο Ultra Configurator. Παροµοίως όταν εκτελείτε 
εντολή του Ultra Configurator είναι παρακινδυνευµένο να εκκινήσετε το Logger.   
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